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This document describes the new features, product enhancements, and other 
improvements implemented in the Dragonfly and Dragonfly Pro 2020.1 software 
release. You should read these release notes before you install this new version.
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New Features
The 2020.1 software release for Dragonfly and Dragonfly Pro provides the following 
new features. See Product Enhancements on page 47 for information about all the 
enhancements for Deep Learning, Machine Learning, and automated segmentation, as 
well as improvements for managing user data and projects.

Next Generation Rendering Engine
Bring your real-world materials to life and produce stunning renderings for animated 
sequences and publication-quality images. The 2020.1 Dragonfly software release 
introduces the next generation of 3D rendering for the high-definition visualization of 
scientific and industrial data. More powerful than ever, Dragonfly's new rendering 
engine delivers faster ray tracing, cleaner sampling, and more accurate lighting and 
shadowing — all within automated steps that save you valuable time.

In addition, the new engine’s interactivity controls for balancing performance and speed 
for different quality graphic cards let you quickly amend scenes, adjust lighting and focus, 
and change material properties. Below are just a couple of examples of the rendering 
results you can expect in the Dragonfly 2020.1 software release.

Previous results (on left) and with Dragonfly’s new rendering engine (on right)

Soybean sample. Data courtesy of Keith Duncan (Donald Danforth Plant Science Center).

Detail of wooden gothic prayer bead. Data courtesy of the University of Western Ontario.
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New Rendering Capabilities
Below are some examples of the new capabilities for visualizing regions of interest and 
for combining regions of interest with graphs. You should note that this rendering 
engine does not require image data to show an ROI in a 3D view.

New rendering capabilities for regions of interest and other objects

Segmented ceramic matrix composite. Courtesy of Aly Badran (University of Colorado).

Segmented solid oxide fuel cell with three‐phase boundary graph. Courtesy of Aaron Stebner 
(Colorado School of Mines).
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Below is an additional example of the capabilities of the new rendering engine for 
combining multiple objects in a single 3D view.

Thickness mesh

Correlative Workflows
User who apply several microscopy techniques to single samples should notice that 
correlative workflows with the new rendering are greatly improved. Challenges for 
rendering low and high resolution datasets with large size differences at acceptable 
speeds have been addressed and resolved. Instead of having to render all datasets at 
the setting of the high-resolution dataset, the new rendering engine can render then at 
a constant rate of 10 to 15 frames per second (FPS). With Dragonfly’s legacy rendering 
engine, rendering a single frame could take up to 30 seconds whenever the size 
difference in the correlative datasets was more than an order of magnitude.

NOTE Correlative workflows allow microscopists to study samples at much greater ranges of 
magnification than with a single technique. Conducting an initial low-magnification 
inspection of a sample to identify specific regions of interest can also generate much 
greater ranges of information about the samples at different scales.

NOTE Examining multiple overlapping datasets in 3D can still affect rendering performance with 
the new engine. You should choose your interactivity settings appropriately (see Scene's 
Views Properties on page 11) when working with multiple volumes and objects in the 
same 3D view.

Thickness mesh of an induced fracture in Berea sandstone core. Courtesy of Zuleima Karpyn, Penn 
State University. Dataset available on the Digital Rocks portal (https://www.digitalrocksportal.org/).
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Enabling the New Engine and Setting Defaults
A number of new items, circled below, are available in the 3D Settings preferences to 
enable the new rendering engine and to set its defaults.

Click the Preferences button on the Status bar or choose File > Preferences on the 
menu bar to open the Preferences dialog. Then choose Views | 3D Settings in the 
Preferences dialog to view the 3D Settings preferences.

New rendering engine preferences 

Use new rendering engine… Lets you toggle between the new rendering engine and the 
legacy version. You should note that a restart will be required after changing the 
rendering engine.

Default preset… Lets you select the 3D preset that will be applied by default (see 3D 
Presets on page 13).

Gamma correction… Lets you select the gamma correction setting that will be applied 
automatically.

Interactivity… Lets you choose an Interactivity option, which lets you balance quality 
and speed for different grade graphic cards at every stage of the visualization workflow 
(see Scene's Views Properties on page 11).

Break during motion… If checked, the quality of visualizations will be decreased during 
manipulations, but will then return to the set quality when at rest (see Scene's Views 
Properties on page 11).
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Scene's Views Properties
A number of new options for adjusting interactivity and focus, as well as for adding 
virtual floors, are available in the updated Scene's Views Properties panel, shown 
below, for the new rendering engine.

Scene's Views Properties panel

New items in the Scene's Views Properties panel for the next generation rendering 
engine are described below. Changes to previous items, which are marked with *, are 
also summarized.

Changes to the Scene’s Views Properties panel

Description

Orthographic projection* Lighting and shadowing controls are available for orthographic projections with the new rendering engine.

Break during motion* If checked, the quality of visualizations will be decreased during manipulations by increasing the size of 

the raycasting steps. For example, when panning, rotating, or adjusting window leveling. Visualizations 

will return to the set quality when at rest. In general, selecting this option may help reduce delays when 

working with large datasets.

NOTE Was previously available as Lower quality in motion.

Edge detect only ROIs If checked, a delineated edge will be applied to the labeled voxels of visible regions of interest. This 

setting can help visualizations in which object boundaries are indistinct.
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Virtual floor If checked, a virtual floor computed from the “Up” position of the camera will be automatically added to the 

view. As shown in the screen capture below, objects can cast realistic shadows on the 'virtual floor'.

NOTE The color of the virtual floor can be selected as a preference (see Views Preferences on page 71).

NOTE Computing virtual floors can be expensive as it is not a hardware accelerated feature and 

interactivity performance will likely decrease. You should apply this feature only when you need to take a 

series of screenshots or to record an animated sequence.

Interactivity Each Interactivity option for Dragonfly’s new rendering engine offers the optimum balance of quality and 

speed for different grade graphic cards and for different stages of visualization workflows.

Best quality… Retains the best quality visualizations during manipulations before returning to the set 

quality.

Quality… Retains good quality visualizations for more limited graphic cards. You can also use this mode 

when you’re nearing the final stages of your visualization process to quickly change and amend your 

scene, enhance lighting, and change material properties.

Balanced… Provides a good balance between quality and speed.

Speed… This mode is ideal when working with lower quality graphic cards.

Fastest with lighting… Lets you quickly make manipulations without any discernible delay, while still 

retaining current lighting.

Fastest without lighting… Lets you quickly make manipulations without any discernible delay, without 

the current lighting applied. Use this mode to speed up your visualization workflow from the beginning 

with almost instant feedback.

NOTE Interactive rendering automatically updates rendered images in real time as you make changes in 

your scene. It is a great aid in modifying and transforming objects, tweaking material properties, adjusting 

lighting and the camera, and virtually any part of the rendered scene.

You should also note that some settings, such as maximized quality, cubic interpolation, gradient filtering, 

and virtual floors, can lead to rendering delays. For more speed, you can turn off some of these GPU-

intensive features until your visualization workflow is complete.

Lighting settings* You should note the following changes for the Lighting settings:

• The new Deepen shadows setting lets you choose to apply deep shadows, or if not selected, to apply 

less harsh shadows.

• The lighting items 'Shadow precision' and 'Spotlight' are deprecated for the new rendering engine.

• The material properties item ‘Shininess” is deprecated for the new rendering engine.

• The material property items 'Specular' and 'Diffuse' have been moved to the 3D settings panel and are 

configurable for each object in the view (see 3D Settings Panel on page 13).

Description
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3D Presets
A new set of 3D presets are available for Dragonfly’s new rendering engine that let you 
quickly create optimized renderings of different materials and samples with a minimum 
of manipulations. These options are available in Presets drop-down menu on the 3D 
presets panel, shown below.

3D presets panel

3D presets are groups of lighting and material settings that are optimized for particular 
data types or materials, such as organic tissue, bone, and solids. For the best 
performance with Dragonfly 2020.1, you should select the 3D preset that is the most 
suitable for your typical data as the default setting (see Enabling the New Engine and 
Setting Defaults on page 10 and Views Preferences on page 71). In addition to the pre-
installed 3D presets, you can also create your own presets.

3D Settings Panel
A number of new options for adjusting the material properties of selected objects and 
for filtering image data are available in the 3D settings panel, which is available on the 
right sidebar and is shown below.

3D settings panel

Focus settings You should note the following new items for adjusting the Focus settings:

Close up… If selected, reduces the minimum focusing distance of the camera. This lets you focus more 

closely to your subject, which gives you greater magnification.

Strength… Lets you adjust the amount of blur applied to the foreground and background areas that are 

outside of the center of focus. You should note that unfocusing image areas can help make a feature of 

interest stand out.

Global volume opacity Lets you adjust the opacity of all image data in a 3D view that does not correspond to the labeled voxels of 

visible regions of interest and visible multi-ROI classes.

NOTE The opacity of the highlight applied to selected regions of interest and multi-ROIs, as well as the 

image data that corresponds to labeled voxels, are adjustable in the 3D opacity panel on the Data 

Properties and Settings panel, as shown below.

Description
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New items in the 3D settings panel for the next generation rendering engine are 
described below. Changes to previous items, which are marked with *, are also 
summarized.

3D settings panel changes

NOTE Some 3D settings, such as cubic interpolation, gradient filtering, and high quality, can 
lead to rendering delays. For more speed, you can turn off some of these GPU-intensive 
features until your visualization workflow is complete.

Description

Solidity Lets you vary the solidity, or opaqueness, of the voxels of the selected object. You should note that this 

non-linear function is applied at every step of the raycasting process in contrast to opacity, which is a 

linear function that determines the transparency of an object.

NOTE In most cases, you should adjust either Opacity or Solidity with their respective sliders.

Diffuse* Determines the strength of diffuse light reflected from the surfaces of objects and is a characteristic of 

light absorbed by surfaces. Increasing this property with the Diffuse slider will result in object surfaces 

being more defined.

NOTE Was previously part of the Scene View's Properties. And is now selectable for each object within a 

3D view.

Specular* Determines the strength of specular reflections originating from the surfaces of an object and is a 

characteristic of light reflected from shiny surfaces. Increasing this property with the Specular slider will 

result in increased reflections. You should note that specular effects will be affected by the Specular 
boost setting, if this settings is selected.

NOTE Was previously part of the Scene View's Properties. And is now selectable for each object within a 

3D view.

Shininess* Determines how much the smooth surfaces of an object reflect light. Increasing shininess will result in 

surfaces that reflect more light and is usually adjusted in conjunction with Specular.

NOTE Was previously part of the Scene View's Properties. And is now selectable for each object within a 

3D view.

Unsharp If checked, objects in the view will be sharpened by increasing contrast along edges and other high 

frequency components.

NOTE The term Unsharp comes from a darkroom technique used in traditional film-based photography in 

which an unsharp or smoothed version of an image is subtracted from the original one.

Tone mapping Tone mapping maps one set of colors to another to approximate the appearance of high-dynamic-range 

images in a medium that has a more limited dynamic range. In Dragonfly, it can be applied to brighten 

datasets that appear too dark.

Filtered gradient If checked, this option will smooth the gradient calculated for lighting. Very similar to tricubic filtering, but 

applied to the gradient with the effect of smoothing areas with abrupt intensity changes.

NOTE An image gradient is a directional change in the intensity or color in an image.

Median If checked, objects will be smoothed by median filtering. When applied, pixel values are replaced with the 

median of itself and their neighbors. This can help remove noise while still preserving boundaries.

Specular boost If checked, adjustments to the Specular setting will be greater.

3D LUT* You should notice that LUTs, which determine how regions within specific arrays of intensity are 

highlighted and how color is applied, are more accurately mapped to the selected window leveling range 

when using the new rendering engine. In comparison to the previous rendering engine, 3D LUTs are 

applied to the whole data range while leveling is applied as a pass-through.

NOTE Applied LUTs can be edited interactively to optimize visualizations.
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Segmentation Wizard
Dragonfly’s new Segmentation Wizard provides an easy-to-use, guided workflow for 
implementing powerful deep learning and classical machine learning segmentation of 
multi-dimensional images. With the Segmentation Wizard, you simply paint the 
different features of interest within a limited subset of your image data and then train 
models to identify objects according to a predefined set of rules. The most promising 
model can then be fine-tuned and exported for repeated segmentation tasks. This 
empowers any user to achieve robust and reproducible segmentation results that are 
not influenced by user bias.

Right-click the image data you need to segment in the Data Properties and Settings 
panel and then choose Segmentation Wizard in the pop-up menu to open the 
Segmentation Wizard context, shown below. The workspace includes a large views area 
in which you can label the voxels within a frame and preview model predictions, as well 
as panels on the right side that include the Input, Models, and Settings tabs.

Segmentation Wizard

NOTE The Segmentation Wizard requires a Deep Learning license. Refer to the topic Licensing 
for Optional Features on page 60 for information about the availability of the optional 
features for Dragonfly 2020.1.
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Key Features and Benefits
Just some of the many key features and benefits of the Segmentation Wizard are listed 
below.

• Automatically splits available data into Training, Evaluation, and Test sets.

• Works on frames that are created automatically on the visible part of the data. 

• Users apply their specific knowledge to identify features of interest by labeling a 
limited subset of the image data that is defined by frames. Advanced knowledge of 
machine learning and deep learning algorithms is not required.

• Direct and quick feedback with previews of model predictions. New frames can be 
filled automatically with the best model prediction, based on the highest-ranked 
prediction.

• Models can be fine-tuned by correcting the most-promising prediction.

Input Tab
The Input tab on the Segmentation Wizard panel, shown below, provides the 
opportunity to add frames on the image data and to define classes. Labeling features of 
interest within frames can be accomplished with the ROI Painter tools. Frames can also 
be filled from previously segmented multi-ROIs.

Input tab about

NOTE Refer to the topic New Options for Multi-ROIs on page 27 for information about the new 
options for working with multi-ROIs in Dragonfly 2020.1.
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Models Tab
The options on the Models tab let you enable or disable models, import trained models, 
as well as to save models for use with the Segment with AI feature (see Automated 
Segmentations on page 55).

Models tab

Settings Tab
The options on the Settings tab, shown below, let you set your training preferences.

Settings tab

You can choose to have new frames filled automatically with the best model prediction, 
as well as determine when model training will be stopped.
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Bone Analysis Wizard
Designed for the evaluation of high-resolution micro-CT samples of bone specimens, 
Dragonfly’s new Bone Analysis Wizard provides 3D vector-based mappings of 
anisotropy magnitude and directionality and 3D scalar-based mappings of bone volume 
fraction. In addition, an automated separation of cortical and trabecular bone drives the 
calculation of common morphometric indices that provide researchers with quantitative 
descriptions of bone micro-architecture.

Right-click the image data from a bone study in the Data Properties and Settings panel 
and then choose Bone Analysis Wizard in the pop-up to open the Bone Analysis Wizard, 
shown below.

Bone Analysis wizard

NOTE Bone Analysis is a separately licensed feature for Dragonfly 2020.1. Refer to the topic 
Licensing for Optional Features on page 60 for information about the availability of all 
the optional features for Dragonfly.

Bone Analysis Workflow
A series of self-guided segmentation steps let you close cortical pores and vascular 
inlets and fill an initial bone segmentation before proceeding to the separation of the 
cortical and trabecular bone, computing morphometric measurements, and generating 
3D vector-based mappings of anisotropy magnitude and directionality and 3D scalar-
based mappings of bone volume fraction. Observations and measurements are 
appended automatically to detailed reports.
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Bone segmentation and filling… The first step in the workflow lets you segment the 
selected bone image and fill the initial segmentation.

Filled bone separation… The second step of the guided segmentation, shown below, lets 
you choose a segmentation method ― Buie or Kohler ― for separating filled bone into 
cortical and trabecular components.

Compute global measurements… The inputs for computing global measurements, as 
described by Bouxsein et al.*, are shown in the following screen capture. These 
measurements rely on input cortical bone and trabecular bone segmentations, which 
offers the opportunity to edit automated bone segmentations, as well as to input any 
region of interest that satisfies the requirements.

* Bouxsein, M.L. et al. Guidelines for assessment of bone microstructure in rodents using micro-
computed tomography. J Bone Miner Res 25, 2010.
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Global Measurements dialog

NOTE You can apply a mask to limit the area in which the selected global measurements will be 
computed.

Compute scalar and vector fields… The parameters to compute scalar values of volume 
thickness and vector fields of anisotropy are available as the next step in a bone 
analysis workflow.
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Compute scalar and vector fields

Prepare Screenshots and Notes… A multiple screenshots panel is available on the left 
sidebar to collect screen captures that can be included in generated reports. Metadata 
can be easily integrated in reports by clicking the Define Image Metadata button on the 
Multiple Screenshots panel. The Multiple Screenshots panel (on top) and Image 
Metadata dialog are shown below.

Generate Report… Lets you generate a report in the PDF file format, which is 
automatically formatted with a header that includes the project title, job ID, author(s), 
contact information, and creation date. You can also add your institution’s logo. 
Computed global measurements and screen captures taken during the current session 
will also be included in the report. You should note that reports use a LaTeX template 
that can be easily modified for specific requirements.
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Plug Analysis Wizard
Dragonfly’s new wizard for Plug Analysis provides a dedicated workflow for analyzing 
core plugs acquired from rock samples and other porous media. It includes powerful 
algorithms that support segmentation with Deep Learning and built-in automation for 
quantitatively extracting computations that add weight to observations from core 
material. Analysis results can be quickly appended to detailed reports that can include 
screen captures, graphs, and other supporting material. Choose Workflows > Plug 
Analysis on the menu bar to open the Plug Analyzer, shown below. You can also open 
the Plug Analysis Wizard from the dataset pop-up menu.

Plug Analysis module

NOTE Plug Analysis is a separately licensed feature for Dragonfly 2020.1 and is not bundled 
with non-commercial licenses. Refer to the topic Licensing for Optional Features on 
page 60 for information about the availability of all the optional features for Dragonfly.

Plug Analysis Workflow
The Plug Analysis workflow includes the pre-processing, segmentation, editing, and 
computation steps described below.

Pre‐processing… The first step in the workflow lets you perform the basic pre-
processing tasks of beam hardening correction and cropping with a cylinder on axial 
and longitudinal views of the loaded image data.

Segmentation… Lets you choose an Otsu threshold, Deep Learning model, or to apply a 
manual range to perform the basic segmentation of the plug components.
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Correct segmentation… The opportunity to correct the automated segmentation by 
applying morphological operators, filling inner areas, or with Dragonfly’s ROI Painter 
tools is then available at this next step of the workflow.

Box editing… The Box Editing step lets you adjust the input and output boxes for 
computing tortuosity and throat-weighted tortuosity from the graph of plug porosity.

Calculations… Lets you choose the measurements and computations you need to add 
fully analyze your core sample (see Plug Measurements on page 23).

Prepare screenshots and notes… A multiple screenshots panel, shown below, is available 
on the right sidebar to collect screen captures for generated reports. Notes can be 
easily integrated in a report by clicking the Define Image Metadata button.

Reporting… Lets you generate reports in the PDF file format, which are automatically 
formatted with a header that includes the project title, job ID, author(s), contact 
information, and creation date. Screen captures taken during the current session, 
thickness mesh measurements, distributions of pore sizes and tortuosity, as well as 
plug porosity measurements can also be included in reports. You should note that 
reports use a LaTeX template that can be easily modified for specific requirements.

Plug Measurements
The analysis capabilities of the dedicated Plug Analysis module are listed below.

Plug Analysis measurements

Description

Plug porosity You can compute plug porosity for each XY slice within the segmented image data on the Slice Analysis 
tab (see Plug Porosity Slice Analysis on page 24).

Thickness mesh Computes color-coded meshes that show referential values of the local thickness. Thickness is calculated 

as the diameter of a hypothetical sphere that fits within each boundary point and is the same as 

computing the volume thickness on the ROI and sampling it on the vertices of the mesh.

Volume thickness Computes and generates scalar-based maps of volume thickness.

Shortest path distance map Computes and generates scalar-based maps of the shortest path distance from the input box to the output 

box defined at the Box editing step of the workflow.

Sparse Graph Computes and generates sparse graphs that include edge scalar measurements of Euclidean length and 

vertex scalar measurements of pore diameter. 

Dense Graph Computes and generates dense graphs that include edge scalar measurements of Euclidean length and 

vertex scalar measurements of segment tortuosity, segment length, segment index, segment Euclidean 

length, pore diameter, Dijkstra Euclidean, Dijkstra Throat Weighted.

The following distributions are also available for reporting as follows:

Pore size distribution… Plots pore size distribution within the dense graph.

Tortuosity… Plots tortuosity within the dense graph (see Tortuosity Distributions for Graphs on page 32).

Throat‐weighted tortuosity… Plots the distribution of throat-weighted tortuosity within the dense graph 

(see Tortuosity Distributions for Graphs on page 32).
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Plug Porosity Slice Analysis
This parameter for slice-by-slice analysis lets you compute plug porosity for each XY 
slice within the volumetric data. The plug porosity percentage of the region of interest is 
computed as: [(total labeled voxels)/(total all voxels)]*100.

Click the Slice Analysis tab on the right sidebar to open the Slice Analysis panel. You 
can then choose the Plug Porosity measurement and click the Compute button to 
generate the results and plotted graph shown below. Select the Add Slice Analysis 
results to report option if want to include this analysis in your generated report.

Slice Analysis panel

If required, you can customize and save the figure, as well as export the results to a 
CSV file for further processing. Plug Porosity measurements are also available in the 
main application for detailed slice analyses of any reformatted view.

Pore Network Modeling
Go further with other unique Dragonfly capabilities, such as pore network modeling, to 
generate and extract pore network models based on 3D image data. The previously 
released Pore Network Modeling module for Dragonfly provides valuable insights into 
pore and throat size distributions as a natural outcome of producing a network model.
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CT Reconstruction Module
The CT Reconstruction module for Dragonfly 2020.1 provides for the tomographic 
reconstruction of cone-beam projections with RTK, an open-source software based on 
the Insight Toolkit (ITK), and parallel-beam projections using TomoPy, an open-source 
Python package for tomographic data processing and image reconstruction. CT 
Reconstruction provides benchmarked reconstruction algorithms, selectable 
reconstruction parameters, iterative methods, and previews for verifying selected 
settings. Extensive knowledge about the integrated image reconstruction algorithms is 
not required to obtain optimal results with CT Reconstruction.

Choose Workflows > CT Reconstruction on the menu bar to open the CT Reconstruction 
dialogs, shown below.

CT Reconstruction options for cone beam and parallel beam acquisitions

NOTE The CT Reconstruction module is only available as Beta in this software release.

Reconstruction Algorithms
CT Reconstruction includes the benchmarked Feldkamp-David-Kress (FDK) algorithm 
for cone-beam acquisitions, and Fourier grid reconstruction ('gridrec') and algebraic 
reconstruction techniques ('art') for parallel-beam. Geometry readers are provided for 
commercial scanners from Nikon, KA Imaging, and North Star Imaging.
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Pre and Post‐Processing
Basic operators for reconstruction include flat and dark-field correction and median 
filtering, while GPU acceleration provides fast processing of large data sizes. 
Downstream, Dragonfly's extensive image processing toolbox includes beam-hardening 
correction, ring artifact removal, noise reduction, and image stack alignment. Batch 
processing allows reconstruction jobs to be run sequentially without operator input.

MC X‐Ray
MC X-Ray simulates electron scattering in materials in order to correlate X-Ray emission 
to composition in quantitative X-ray microanalysis. By simulating X-ray spectra, it is 
possible to establish the optimum conditions to perform a specific analysis, as well as to 
establish detection limits or to explore possible peak overlaps.

MC X-Ray can compute the complete X-ray spectra from the simulation of electron 
scattering in solids of various types of geometries and allows for up to 256 different 
regions in the materials having the shape of spheres, cylinders, and combinations of 
horizontal and vertical planes. All of these regions can have a different composition.

Choose Workflows > MC X‐Ray Simulator to open the MC X-Ray dialog, shown below.

Physical Models tab on the MC X‐Ray dialog

NOTE The MC X-Ray module is only available as Beta in this software release.

Additional features of MC X-Ray include bright-field, dark-field, and high angle annular 
dark-field detectors, as well as the display of electron trajectories, electron and energy 
distribution at the specimen surfaces, transmitted electrons distribution, and energy 
loss distribution.
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New Options for Multi‐ROIs
The 2020.1 software release introduces the concept of editable multi-ROIs. This means 
that you can create and label classes directly on a multi-ROI instead of working on 
multiple regions of interest and then creating the multi-ROI.

As shown in the following screen capture, the new Classes and scalar information box 
on the Data Properties and Settings panel for selected multi-ROIs indicates the name of 
each class in the multi-ROI, the number of labeled voxels, and the color assigned to 
each class. If available, you can also view scalar information related to each class. In 
addition, you can show or hide any class by toggling the visibility control.

Classes and scalar information for multi‐ROIs

NOTE The Pick tool lets you visually select a class within a view.

Background Class
If this option is enabled, labeled voxels that are removed from any class, as well as 
unlabeled voxels that are painted, will be added automatically to the set background 
class.

Do the following to set a class as the background for a multi-ROI:

• Name the class that you intend to set as the background, recommended.

• Drag the class to the Background class box and drop it when the “+” appears with 
your cursor.

• To remove the background class, check the None option.
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Scalar Information
Scalar information related to each class in a multi-ROI, whether it was generated or 
imported, appears in the Classes and scalar information list and is selectable in the 
Scalar information box that is circled below.

Scalar information box

Labeling Multi‐ROIs with the Painter Tools
You can use the tools available on the ROI Painter panel, shown below, to manually 
label the voxels of each class in a multi-ROI.

ROI Painter panel

NOTE The labeled voxels of the classes in a multi-ROI cannot intersect. For example, if you are 
labeling voxels as 'Class 1' and paint over the labeled voxels of another class, then those 
voxels will be automatically labeled as 'Class 1'.

In cases in which a feature of interest was misidentified as belonging to another class, 
for example by the Segmentation Wizard during model training, you can edit labels in 
'Exclusive' mode. In this mode, only labeled voxels within the selected classes will be 
affected by painting. For example, if you select classes A and B and then add to class A, 
only voxels labeled as class B will be automatically relabeled as class A.

You can also edit the labels of each class within a multi-ROI by applying morphological 
operators and other operations, such as filling inner areas and adding clipped regions. 
Additional options are available in the Classes and scalar information pop-up menu to 
label all non-intersected voxels, clear classes, and import the labels of a region of 
interest (see Options for Selected Classes on page 29).
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Options for Selected Classes
Contextual menu items for single selections and multiple-class selections let you fully 
segment the multi-ROI, as well as clear, delete, and merge classes. You can also extract 
classes as ROIs for other purposes.

Single selection (on left) and multiple (on right) options

Creating New Multi‐ROIs
The options to create a new multi-ROI with a selectable number of classes is available 
from the ROI Tools panel. Click the New button in the Basics box to open the New 
Region of Interest dialog, shown below.

New Region of Interest dialog

Creating Dense Multi‐ROIs from ROIs
The option to create new multi-ROIs, in which the labeled voxels of each selected ROI is 
assigned to a class and all unlabeled or 'complementary' voxels are labeled as an 
additional class, is available from the pop-up menu for selected regions of interest. For 
example, if you create a multi-ROI from five regions of interest, then the dense multi-
ROI will contain six classes and will be fully segmented.

As shown in the following illustration, in which the labeled voxels of three regions of 
intersect, the selection order determines how labeled voxels are distributed in the 
resulting classes of the multi-ROI. Unlabeled voxels are assigned to an additional class.

Intersecting ROIs and resulting dense multi‐ROIs
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You should note that dense multi-ROIs are often selected as the output for training 
deep learning models.

Creating Dense Multi‐ROIs from Multi‐ROIs
The option to create new multi-ROIs, in which all unlabeled or 'complementary' voxels 
are labeled and assigned to a new class, is now available from the pop-up menu for 
selected multi-ROIs. For example, if you create a dense multi-ROI from a multi-ROI 
that contains five classes, then the dense multi-ROI will contain six classes and will be 
fully segmented.

2D Watershed
In cases in which you need to prepare training data for Deep Learning, you can perform 
a watershed segmentation on a single slice of a labeled multi-ROI.

Right-click the required multi-ROI in the Data Properties and Settings panel and then 
choose 2D Watershed in the pop-up menu. You will then need to choose a region of 
interest for computing a distance map, as well as a landscape for computing the 
watershed. The result will be a fully segmented, single-slice multi-ROI.

Creating Images from Selected Scalars
This new option for multi-ROIs automatically creates an image for each scalar value 
checked in the Select Desired Scalars dialog, shown below

Select Scalars dialog.

The result is series of new images in which data values correspond to the scalar values 
of labeled voxels.

NOTE Images are generated in the FLOAT data type, which stores double-precision floating-
point numbers with up to 17 significant digits.
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Measurements for 2D Multi‐ROIs
A number of new options are available in this software release for measuring the 
properties of the labeled regions, or connected components, on 2D multi-ROIs.

Right-click a multi-ROI in the Data Properties and Settings panel and then choose 
Connected Components > Analysis in the pop-up menu to start your analysis. The 
following properties can then be selected in the Statistical Properties dialog in the 
Object Analysis module.

Statistical Properties for 2D multi‐ROIs

Descriptions of the selectable statistical properties for 2D multi-ROIs are available in 
the following table.

Selectable statistical properties for 2D multi‐ROIs

Description

2D Area The area of the labeled pixels in the region, reported in (default units)2.

2D Bounding Box Area The area of the bounding box that encloses the labeled pixels in the region, reported as (default units)2.

2D Convex Area The area of the convex hull image, which is the smallest convex polygon that encloses the region. 

Reported in (default units)2.

2D Eccentricity Eccentricity of the ellipse that has the same second-moments as the region. The eccentricity is the ratio of 

the focal distance (distance between focal points) over the major axis length. The value is in the interval 

[0, 1]. When it is 0, the ellipse becomes a circle.

2D Equivalent Diameter The diameter of a circle with the same area as the region, reported in default units.

2D Euler Number Euler characteristic of the region.

2D Extent Ratio of pixels in the region to pixels in the total bounding box. Computed as:

2D Area / 2D Bounding Box Area.

2D Filled Area The area of all pixels — both labeled and unlabeled — in the region  which describes the area of the filled 

region. Reported in (default units)2.

2D Major Axis Length The length of the major axis of the ellipse that has the same normalized second central moments as the 

region. Reported in default units.
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Tortuosity Distributions for Graphs
As a new feature for computed graphs, you can plot the distribution of graph tortuosity 
and throat-weighted tortuosity between input and output boxes. You should note that 
the tortuosity factor is a measure of the departure of a porous medium from the ideal 
system made of straight and parallel capillaries.

Histograms of tortuosity and throat‐weighted tortuosity

Plotting Tortuosity
Do the following to plot the distribution of tortuosity within a graph of porous media:

• Add box shapes to define the input and output of the segment of the graph that you 
want to plot.

• Right-click the graph in the Data Properties and Settings panel and then choose Plot 
Graph Tortuosity in the pop-up menu.

2D Minor Axis Length The length of the minor axis of the ellipse that has the same normalized second central moments as the 

region. Reported in default units.

2D Orientation Angle between the 0th axis (rows) and the major axis of the ellipse that has the same second moments as 

the region, ranging from -pi/2 to pi/2 counter-clockwise. Reported in degrees or radians.

2D Perimeter Perimeter of object which approximates the contour as a line through the centers of border pixels using a 

4-connectivity. Reported in default units.

2D Solidity Ratio of pixels in the region to pixels of the convex hull image.

Description
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• Choose the input and output boxes, as shown below.

• Click OK to plot the tortuosity within the selected segment of the graph.

Plotting Throat‐Weighted Tortuosity
Do the following to plot the distribution of throat-weighted tortuosity within a graph of 
porous media:

• Add box shapes to define the input and output of the segment of the graph that you 
want to plot.

• Right-click the graph in the Data Properties and Settings panel and then choose Plot 
Graph Throat‐Weighted Tortuosity in the pop-up menu.

• Choose the graph region of interest, as well as the input and output boxes, as shown 
below.

• Click OK to plot the throat-weighted tortuosity within the selected segment of the 
graph.

Computing Shortest Distances on Graphs
This software release provides the option to compute the shortest distance between two 
selected nodes on a graph and to then extract additional scalar values within that 
interval. Choose Utilities > Start Graph Shortest Path on the menu bar to open the 
Graph Shortest Path dialog, shown below.

Graph Shortest Path dialog
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Do the following to compute the shortest distance between two selected nodes:

• Pick a path-starting vertex and a path-ending vertex with the Pick tool.

• Choose a measurement in the Edge measurement drop-down menu.

• Click the Compute path button.

The shortest path between the selected vertices is computed automatically and the 
Edge LUT measurement is updated to highlight the computed path, as shown below.

In addition, specific measurements extracted from the edges within the path appear 
in the Graph Shortest Path dialog. These include the total of the selected 
measurements, the minimum, maximum, and mean values, as well as the variance.

• If available, you can choose other edge measurements to examine in the Current slot 
drop-down menu, as shown below.

Configured Actions for Computing Shortest Distances
The following configured actions are available for picking vertices with the Pick tool.

Configured actions for computing distances

Description

Pick path ending vertex Configured action for picking the path-ending vertex.

Pick path starting vertex Configured action for picking the path-starting vertex.

Pick vertices Configured action for entering vertex-picking mode.

Switch to pick end vertex Configured action for switching to pick path-ending vertex mode.

Switch to pick start vertex Configured action for switching to pick path-starting vertex mode.
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Import Graph from CSV
This new option, which is available on the File menu, lets you import a graph saved in 
the comma-separated values (*.csv extension) file format.

Probing Graph Scalar Values
You can now view the scalar values of graph edges and/or nodes, as well as assigned 
index numbers, in 3D views with the Probe tool. Results are displayed on the Probe 
panel, as shown below.

Probe panel

NOTE The Probe panel is available by default on the left sidebar on the Main tab.
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Scalar Values for Meshes
This software release includes the option to add additional scalar values, such as 
curvature, normal angles with the Z-axis, or a constant, to meshes.

Right-click a mesh in the Data Properties and Settings panel and then choose the 
required option in the pop-up menu. The computed scalar value will appear in the 
Scalar information group box, as shown below, and will be displayed on the legend.

Scalar information

You should note that you can map values to any LUT. In the following example, the 
default blue-green-yellow LUT was selected for mapping normal angles with the Z axis.

Normal angles with Z axis

Translation for Scalar Values
If required, you can apply a linear transformation, with or without an offset, to selected 
mesh scalar data. Right-click the mesh in the Data Properties and Settings panel and 
then choose Apply Translation to Scalar Values in the pop-up menu. You can then 
choose the scalar values slot that you need to modify in the Choose a Scalar Values 
Slot dialog, as well as the slope value and offset in the following dialogs.
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Image Filtering
A number of new options, as well as additional filters, are available in this software 
release for processing and filtering image data.

Apply to Selected Slices Only
As an update for image processing, you can now restrict the application of a filter or 
arithmetic operation to selected image slices. For example, to correct an anomaly that 
only appears a limited number of slices on a 3D image.

Do the following to apply filtering to selected slices only:

• Mark the image slices to which you want to restrict processing.

NOTE Right-click inside the view of the original data and then choose Show Marked 
Slices Indicator in the pop-up menu to view the options for marking image slices.

• Choose Apply > On selected slices in the Output box on the Image Processing panel, 
as shown below.

• Choose the slices, or a range of slices, on which the selected operation should be 
applied in the Selected Slices dialog, as shown below.

NOTE You can also extract a dataset of selected slices only by checking the Discard 
other slices option.

Additive Noise Filter
The new Additive Noise filter lets you artificially add noise to an image. Deliberately 
corrupting an image with noise lets you test the resistance of an image processing 
operator to noise and assess the performance of various noise reduction filters and 
denoising models.
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The result of adding noise to a grayscale image is show below on an intensity profile.

The following options are available for the Additive noise filter in the Image Processing 
panel.

Options for additive noise

Distribution… Lets you choose a distribution for the added noise — Uniform absolute, 
Uniform relative, and Gaussian.

Range… Lets you choose the range of data within which noise will be added. For 
example, at a range of 100 with a ‘Uniform relative’ distribution, noise will be added 
within ±50 of the original data.
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Find Path Between ROIs
This new option for Dragonfly 2020.1 lets you define the connectivity of the strongest 
path between two regions of interest.

Path ROIs computed with varying geometrical biases

Do the following to compute a path ROI between two ROIs:

• Define the start and end nodes as regions of interest and then create a mask ROI 
to contain the path, recommended.

• Right-click the image data on which you want to compute the path and then 
choose Find Path ROI Between ROIs in the pop-up menu.

• Choose the starting point ROI and end point ROI in the Choose an ROI dialog.

• Choose an ROI as the mask, recommended, and then click OK.

• Select a geometrical bias and then click OK the compute the path.

The new path ROI appears in the Data Properties and Settings panel.

Euler Characteristic Number
Euler Characteristic numbers provide topological characteristics of various classes of 
geometric figures based only on a relationship between the numbers of vertices (V), 
edges (E), and faces (F) of the figure. This number, given by V - E + F, is the same for 
all figures whose boundaries are composed of the same number of connected pieces.

To compute the Euler characteristic number, right-click a region of interest or graph in 
the Data Properties and Settings panel and then choose Get Euler Characteristic 
Number in the pop-up menu. The result appears in an Information dialog.
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Structured Grids Comparator
The new Structured Grids Comparator for Dragonfly 2020.1 lets you evaluate the 
quality of processed image data and segmentations with a number of metrics.

Choose Structured Grids Comparator in the Utilities menu to open the Structured Grids 
Comparator dialog. You can then select a ground truth, mask, and the required metrics 
to evaluate your data. You should note that results are cumulative and can be exported 
in the comma-separated values (*.csv extension) file format for further analysis or 
archiving.

NOTE The structured grids that you choose to compare must have the same size and shape, as 
well as the same resolution.

Processed Image Comparator
For processed image data, you can select metrics such as Mean Squared Error (MSE), 
Normalized Root Mean Square Error (NRMSE), Peak Signal-to-Noise Ratio (PSNR), and 
Structural Similarity Index (SSIM), to evaluate the quality of images generated by 
denoising deep learning models or that were processed by filtering or any other 
operation.

Structured Grids Comparator results for processed image data

NOTE You can open the Processed Image Comparator from the Data Properties and Settings 
panel by multi-selecting the ground truth and processed image data, right-clicking, and 
then choosing Open Processed Image Comparator in the pop-up menu.

Segmentation Comparator
For regions of interest and multi-ROIs, you can select metrics such as Accuracy, Dice 
Similarity Coefficient (DICE), False Negatives (FN), False Positives (FP), and others to 
evaluate the quality of machine learning and deep learning segmentation models.
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Segmentation Comparator results for evaluating a multi‐ROI

NOTE You can open the Segmentation Comparator from the Data Properties and Settings panel 
by multi-selecting the ground truth and segmentation of interest, right-clicking, and then 
choosing Open Segmentation Comparator in the pop-up menu.

Distributed Tasks
This new option for Dragonfly 2020.1 lets you dispatch demanding tasks, such as 
reconstructing cone-beam projections, simulating X-ray emissions, and training deep 
models, to multiple machines.

Choose Preferences > Distributed Tasks to open the preferences for selecting a task 
database connection.

Distributed Tasks preferences

NOTE This module is standard for Dragonfly HPC and is also available on demand for holders of 
multiple Dragonfly and Dragonfly Pro commercial licenses. It is not available for free non-
commercial licenses.
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Creating Image Masks
This new option for Dragonfly 2020.1 lets you quickly create an ROI mask for 
processing image data. Right-click the required image data in the Data Properties and 
Settings panel and then choose Create Mask in the pop-up to open the Create Mask 
panel, shown below.

Create Mask panel

The resulting mask will be a new region of interest with the same shape as the selected 
image data and that is fully labeled within the selected dimension and increment.

Auto Synchronization Between 2D and 3D Views
With the Auto Synchronization option for Dragonfly 2020.1, you can automatically 
update the slice position of all the MPR views in the current scene to wherever you 
clicked in the 3D view.

NOTE The configured action for this option is “Center MPR 2D views from 3D pick” (see 
Configurable Actions on page 71).

Import Images from Hitachi SEM
Support for importing images acquired with Hitachi scanning electron microscopes is 
available in this software release. Simply add the required TIFF file to Dragonfly's 
Image Loader and the application will apply the information available in the 
accompanying “image_file_name.txt” file to correctly import your Hitachi SEM 
acquisitions.

NOTE See Measurements for 2D Multi-ROIs on page 31 for information about the new options 
are available in this software release for measuring the properties of the labeled regions 
on 2D multi-ROIs.
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Export Images as DICOM
This software release provides the option to export images in the DICOM format. 
Whenever you export images in the DICOM format, you can choose the images to be 
exported and an export destination.

Choose Export > As DICOM in the Data Properties and Settings panel to open the 
Export as DICOM Images dialog, shown below.

Export as DICOM Images dialog

NOTE Digital Imaging and Communications in Medicine (DICOM) is a standard for handling, 
storing, printing, and transmitting information in medical imaging. It includes a file format 
definition and a network communications protocol that uses TCP/IP to communicate 
between systems. DICOM files (*.dcm extension) can be exchanged between two entities 
that are capable of receiving images and data in DICOM format.

Exporting Screenshots
A number of additional options are available for exporting screenshots of 2D and 3D 
views. These new options are described below.

Export Screenshots from Views
The option to export screenshots is now available from the contextual menus for 2D and 
3D views, as shown below.

View contextual menu
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Export Screenshots with Transparent Backgrounds
The option to export screenshots from 3D views with a transparent background is 
available in this software release. Select Alpha background in the Screenshot Size 
dialog, shown below, to export the image in the PNG and TIFF file formats with a 
transparent background.

Screenshot Size dialog

Export Meshes with Color
The option to export scalar meshes with colors preserved is now available for the VRML 
(*.wrl extension) file format. Right-click the mesh you need to export and then choose 
Export > Mesh to File with Colors in the pop-up menu.

NOTE Importing meshes exported with color in the VRML file format is not yet supported by 
Dragonfly.

Context Groups
This software release provides the option to save and load ‘context groups’, which 
define the workspace of contexts ― such as the Segmentation, Plug Analyzer, or Bone 
Analysis Wizards ― and include all objects associated with the context. This lets you 
resume working within a specialized workflow after exiting the context or Dragonfly 
without having to import the required objects or to repeat computational steps.

Context groups appear on the Data Properties and Settings panel in the main context, 
as shown below.

Context group in the Data Properties and Settings panel (circled)

To load a context from the main application window, right-click the required group in 
the Data Properties and Settings panel and then choose Reopen in the pop-up menu.
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You can also import a context group from a saved session. Choose File > Import 
Object(s) on the menu bar and then select the ORSSession (*.ORSSession extension) 
file with the required session group. You can then select the group that you want to 
import in the Select Objects dialog.

Select Objects dialog

Widget Observer
This new software developer tool helps you to troubleshoot issues, such as unequal 
panel sizes, misaligned icons, and missing styles, by letting you examine the properties 
of the parents and childs of a selected widget.

Choose Developer > Widget Observer on the menu bar to open the Widget Observer 
panel, shown below.

Widget Observer panel

You can then open a single Widget Observer or Graph Observer, as shown in the 
following screen captures. To view the properties of a widget you can enter the object 
ID or use a configured action to show the properties of the selected instance of class 
(see Configured Actions for the Widget Observer on page 46).
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Widget Observer and Graph Observer dialogs

Configured Actions for the Widget Observer
The following configured actions are available for opening the Widget Observer panel 
and associated dialogs.

Configured actions for the Widget Observer

Description

Open the Widget Observer Opens the Widget Observer panel on the right sidebar.

Start Widget Observer (graph) on 

widget at cursor

Opens the Graph Observer and displays the properties of the selected instance of a class. For 

example, ‘OrsPythonPlugins.OrsBasicManipulate.mainform.mainform’.

Start Widget Observer (single widget) 

on widget at cursor

Opens the Widget Observer and displays the properties of the selected instance of a class. For 

example, ‘OrsPythonPlugins.OrsBasicManipulate.mainform.mainform’.
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Product Enhancements
This release provides the following product enhancements for Dragonfly 2020.1. 
Information about new features, such as the Segmentation Wizard, Plug Analysis, and 
the CT Reconstruction, as well newly implemented options for multi-ROIs and graphs, is 
available in the topic New Features on page 7.

Refactored Menu Bar
One of the first changes you should notice in Dragonfly 2020.1 is the refactored menu 
bar, shown below.

Menu bar

Refactoring was implemented to help make finding the items that you need for your 
workflows easier and quicker. For details about the items available on the menu bar, see 
Menu Bar Changes on page 63.

Deep Learning Improvements
This software release features a number of enhancements and other changes for Deep 
Learning. These modifications are summarized below.

New Class Pattern
• Deep models are now divided into two types — Regression and Segmentation. There 

are no longer separate categories for binary and multi-class segmentations. The 
Model Generator was updated to support only two model types.

• Segmentation deep models now only accept multi-ROIs as the target output and 
produce multi-ROIs as previews and segmentations.

NOTE Refer to the topic New Options for Multi-ROIs on page 27 for information about 
creating and labeling classes directly in multi-ROIs and other options.

• Segmentation class settings — visibility, name, and color — are now part of the deep 
model. Default settings are created to be consistent with old versions.

• The number of classes — Class count — selected for a segmentation model in the 
Model Generator dialog and the number of classes in the output target multi-ROI 
must be the same. In previous versions, the model assumed that output multi-ROIs 
contained an additional unspecified background class. For example, the output multi-
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ROI for a segmentation model with a Class count of four previously needed to contain 
only three classes.  

• Masks are auto generated from labeled voxels.

• Training patches have to be 100% labeled to be included in training, not 50% as 
previously. 

• The method by which data is sampled for training has been changed — from 
generated patches sampling to grid sampling.

Class Settings
Class settings are now displayed in a table on Model Overview screen, as shown below, 
even if model is not loaded. If required, class names and assigned colors can be edited 
here.

Class settings

Class models that previously required multi‐ROIs with three classes (left), now need 
multi‐ROIs with four classes (right), as shown above.
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Multi‐Input and Multi‐Slice Models
Dragonfly’s Deep Learning tool now supports multiple inputs, as well as multi-slice 
models. These options can be selected in the Model Generator dialog as the Input count 
and Input dimension options and then configured on the Model Training panel.

Model Generator dialog (above) and Model Training panel (below)

Training
The following changes are implemented for training deep models:

• The default training parameters are now selected more carefully.

• No more global shared parameters, such as data augmentation, validation, and so on. 
All training parameters are saved as a file in the model folder each time that a model 
is trained.

• Training log history can be displayed from the Model contextual menu, as shown 
below.
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• The TensorBoard callback is now always used and was removed from the UI. This 
callback writes a log for TensorBoard, which lets you to visualize dynamic graphs of 
your training and test metrics, as well as activation histograms for the different layers 
in your model. TensorBoard is a visualization tool provided with TensorFlow.

• The Training Progress bar, shown below, was updated to provide more detailed 
feedback about the real-time status of training.
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You can also view training progress and the results of each epoch in a list view, as 
shown below.

• Models can be unloaded to release GPU memory.

• Model status was expanded with additional descriptors — Not loaded — and color-
coding for easy identification.

Selectable GPU for Deep Learning
A new preference for selecting a specific GPU device to use for Deep Learning is now 
available in cases in which you have multiple GPUs and need to set one of them for 
Deep Learning.

Go to Preferences > Miscellaneous to open the preferences for the available GPU 
cards, circled below.
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Improvements for Machine Learning Segmentation
The Machine Learning Segmentation Tool, which provides classical machine learning 
segmentation of multi-dimensional images and was previously referred to as the 
Segmentation Trainer, was reformatted for this software release to mirror the look and 
feel of Dragonfly’s Deep Learning Tool.

Choose Artificial Intelligence > Machine Learning Segmentation on the menu bar to 
open the Machine Learning Segmentation dialog, shown below.

Machine Learning Segmentation dialog

Changes implemented for machine learning segmentation include the following:

• Some items were re-distributed on the Model, Input, Method, and Results tabs.

• Class definitions, including name, color, and visibility, are available on the Model 
Overview panel.
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• The number of training voxels that intersect with the applied mask is indicated on the 
Input panel, as shown below.

• Output targets are now multi-ROIs, not ROIs.

NOTE Refer to the topic New Options for Multi-ROIs on page 27 for information about 
creating and labeling classes directly in multi-ROIs and other options.

Edit Deep Model Filters
Additional changes to the Machine Learning Segmentation Tool include the option to 
edit deep model filters, such as activation maps.

Right-click a Deep Model filter in the Features tree on the Method tab and then choose 
Edit in the pop-up menu to open the Feature Preset dialog, shown on the following 
page. You can then edit the filter parameters.
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Feature Presets dialog



Product Enhancements
 Automated Segmentations 55

Object Research Systems

T
M

0
2

1
-A

-0
7

Automated Segmentations
A number of updates for automated segmentations are available in this software release 
in the Segment with AI feature. The updated panel, which replaces the one previously 
available as Segment with Classifier, is available on the Segment tab on the left sidebar 
by default.

Segment with AI panel

The changes implemented for segmenting image data with the Segment with AI feature 
are summarized below.

• Models are sorted by class count and are no longer separated between deep models 
and machine learning classifiers.

• You can view the name and associated color of each class in a selected model, as well 
as set visibility for previews, in the Classes box.

• Regression models have been removed. You should note that these models are 
available in the Comprehensive filters for image processing.

• For 3D models, you can choose the reference slice and spacing for applying previews 
and segmenting the selected data. These options are available as shown below.

• The option to segment all slices or selected slices, as well as to apply the model within 
a mask are now available, as shown below.
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Dataset Sampler
As an added option for modifying data, you can now downsample and upsample by a 
random factor. Right-click the data you need to modify and then choose Modify and 
Transform > Sample in the pop-up menu to open the Dataset Sampler panel.

Dataset Sampler panel

Export Histogram Data in CSV
This software release provides the opportunity to export histogram data in the comma-
separated values (*.csv extension) file format for further analysis or archiving.

This option is available for histograms computed from:

• Image data and regions of interest and in the Compare Histograms dialog.

• The Object Analysis dialog, when in histogram view. For example, the histogram of 
Phi versus Theta.

• The Histographic Segmentation dialog. For example, image data versus the Sobel 3D 
of the image data.

• The Slice Analysis panel.

Click the Export to CSV button, as shown below, from any of the above to export  
histogram data in the CSV file format.

Export to CSV option for histograms
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Changes for Annotations
The changes described below are available for annotations, such as rulers, angles, and 
regions, in the Dragonfly 2020.1 software release.

Constrain Ellipse Tool
You can now constrain the Ellipse tool to a circle by configuring a keyboard shortcut for 
the action ‘Constrain ellipse to be round’.

Custom Captions
In this software version, you can add custom captions to rulers, angles, and other 
annotations. Custom captions are available in the Properties box on the Data Properties 
and Settings panel for selected annotations.

To create a custom caption, choose Custom in the Caption drop-down menu and then 
enter a caption in the Custom caption edit box.

Annotation properties

Additional Options for Shapes
The following options are now available for Shapes in this software release.

Selectable Sizes and Orientation
The software release adds the options to automatically align boxes, capsules, cylinders, 
and spheres with a selected dataset, as well as to set the dimensions of a shape. These 
options are available on the Data Properties and Settings panel for selected shapes, as 
shown below.

Size panel
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Extract Structured Grids
The option to extracted structured grids from a dataset is now available for capsules, 
cylinders, and spheres. This feature was previously limited to boxes.

Right-click the required shape in the Data Properties and Settings panel and then 
choose Extract Structured Grid in the pop-up menu to open the Choose a Name and a 
Dataset dialog, shown below. You can then enter a name for the extracted structured 
grid and the object from which the intersecting data values will be extracted.

Choose a Name and a Dataset dialog

Application of 3D Visual Effects
For single shapes, such as a box or visual plane, you can now set applied 3D visual 
effects to the inside or outside of different objects. This can be particularly useful when 
creating animated sequences with Dragonfly’s Movie Maker.

In the example below, clipping was applied to the inside of a box for a thickness mesh 
and to the outside of the same box for the corresponding image data.

Clip applied inside and outside of multiple objects
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Scene’s Views Properties Panel
A number of new items and additional changes were implemented for the Scene’s Views 
Properties panel to accommodate the advanced capabilities of the new rendering engine 
for Dragonfly 2020.1. These changes are itemized in the topic Scene's Views Properties 
on page 11.

3D Settings
A number of new options are available for adjusting the visualization of image data and 
other objects in the 3D settings box on the Data Properties and Settings panel when 
using the new rendering engine for Dragonfly 2020.1. These changes are itemized in 
the topic 3D Settings Panel on page 13.

Updates for the Organizer
A set of new preferences and pop-up menu items are available for the Organizer in this 
software release. In addition, an updated progress bar now shows the progress of file 
downloads.

Organizer Preferences
The following preferences are available for the Organizer. 

Start the Organizer automatically… If selected, the Organizer will appear automatically 
onscreen whenever you start Dragonfly.

Synchronize object names with Properties list… If selected, object names will be 
synchronized between the Organizer and the Properties list.

Pop‐Up Menu Items
The following contextual menu item is available for objects selected in the Organizer:

Show File in New File Browser… Opens your file browser at that location of the selected 
item.
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Managing User Data
Previous Dragonfly releases offered the option to add descriptions to selected objects, 
such as image data, regions of interest, meshes, and so on. This software release 
provides the additional option to add any number of field names and associated values 
to an object description.

Right-click an item in the Data Properties and Settings panel and then choose Manage 
User Data in the pop-up menu to open the User Data dialog, shown below.

User Data dialog

NOTE Object descriptions entered in previous Dragonfly versions will be migrated automatically 
to the new dialog. The ‘Manage User Data’ item was previously named ‘Edit Object 
Description’.

Licensing for Optional Features
You should note that commercial users will require a separate license for each optional 
feature that is available for Dragonfly 2020.1. These features include the following:

• Deep Learning… Includes the Deep Learning Tool, with which you can train deep 
models for image segmentation and regression tasks. Also included with this 
feature is the Segmentation Wizard, which provides an easy-to-use, guided 
workflow for implementing deep learning and classical machine learning 
segmentation of multi-dimensional images (see Segmentation Wizard on page 
15).

You should note that additional features, such as Segment with AI, will be limited 
to classical machine learning models without a license for Deep Learning.

• Auto Process… Enables real-time processing of serial section 2D stack 
experiments. You should note that Auto Process is now a standard feature for 
Dragonfly Pro.

• Bone Analysis… This feature is designed for the evaluation of high-resolution 
micro-CT image data of bone specimens (see Bone Analysis Wizard on page 18).

• Hyperspectral Image Analysis… Facilitates the interactive visualization, 
manipulation, and analysis of hyperspectral images.

• Image Stitcher… Lets you precisely combine, or stitch, overlapping 2D or 3D 
image tiles to create a single high-resolution image that is beyond the normal 
resolution of a microscope’s field of view.

• Organizer… Provides an easy way to organize, manage, and share data and 
analysis results.
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• Plug Analysis… This new feature for Dragonfly provides a dedicated workflow for 
analyzing core plugs acquired from rock samples and other porous media (see 
Plug Analysis Wizard on page 22).

NOTE The optional features listed above for Dragonfly 2020.1, except for Plug Analysis, are 
bundled with non-commercial licenses and do not require any additional activation keys.

Academic Licensing Requests
You should note that starting with version 2020.1, academic licensing requests can be 
made directly from Dragonfly.

Choose Help > Request Non‐Commercial License on the menu bar to open the Request 
Non-Commercial License dialog, shown below.

Request Non‐Commercial License dialog

NOTE You must provide your credentials and a photo of the ID issued by your institution, as well 
as complete the online survey, to request a non-commercial license.

Proxy Server Settings for License Activations
In most cases, systems must be connected to the Internet to activate a Dragonfly 
license. If the Internet connection at your facility runs through a proxy, you can now 
configure a proxy server in the Proxy Configuration dialog, shown below, whenever you 
activate a Dragonfly license.

To open the Proxy Configuration dialog, click the Configure Proxy button, shown below, 
in the Activate Product dialog.

Proxy Configuration dialog
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Mapping for Configured Actions
You can now include the Menu key when you configure a shortcut for a configured 
action. This new option is circled on the screen capture of the Configure Action dialog 
and is shown below.

Configure Action dialog

Developer Documentation
The developer documentation for Dragonfly has been updated for version 2020.1. 
Choose Developer > Developer Documentation on the menu bar to open the 
documentation system.
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Menu Bar Changes
The following changes and new items for the refactored menu bar are implemented for 
Dragonfly 2020.1.

File Menu
The new items listed below are available for the File menu. Other changes are also 
noted.

File menu changes

* New for version 2020.1.

Workflows Menu
This new menu contains items originally available in the Tools menu, as well as a 
number of new items.

Workflows menu

* New for version 2020.1.

Description

Import Graph from CSV* Lets you import a graph that was saved in the comma-separated values (*.csv extension) file format.

User Profile Opens the User Profile dialog, in which you can enter your name and contact information, as well as add 

a copyright notice.

NOTE Was originally available in the Help menu.

Description

Image Filtering Opens the Image Filtering module, in which you can process images using standard image filters, deep 

learning models, and arithmetic operations.

Active Contour Opens the Active Contour module, in which you can quickly and efficiently perform segmentation tasks 

using the active contour model.

Histographic Segmentation Open the Histographic Segmentation module, in which you can quickly segment image data by 

selecting clustered data values.

Hyperspectral Image 

Analysis
Opens the HyperChannels panel on the left sidebar. This module facilitates the interactive visualization, 

manipulation, and analysis of hyperspectral images.

Pore Network Modeling Opens the Pore Network Modeling module, which provides a ready-made framework for performing a 

wide range of pore network simulations.

Plug Analysis* Opens the Plug Analysis wizard, which provides a dedicated workflow for analyzing core plugs acquired 

from rock samples and other porous media (see Plug Analysis Wizard on page 22).

CT Reconstruction* Opens the CT Reconstruction module, which provides tomographic reconstruction of cone-beam and 

parallel-beam acquisitions (see CT Reconstruction Module on page 25).

MC X-Ray Simulator* Opens the MC X‐Ray module, which can simulate electron scattering in materials in order to correlate X-

Ray emission to composition in quantitative X-ray microanalysis (see MC X-Ray on page 26).
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Artificial Intelligence Menu
This new menu contains items originally available in the Tools menu, as well as a 
number of new items.

Artificial Intelligence menu

Utilities Menu
This new menu contains items originally available in the Tools menu, as well as a 
number of new items.

Utilities menu

Description

Machine Learning 

Segmentation
Opens the Machine Learning Segmentation Tool, which is an advanced machine learning plug-in for 

image segmentation.

NOTE Was previously named ‘Segmentation Trainer’.

Deep Learning Model 

Evaluation Tool
Opens the Model Evaluation dialog, in which you can compare the results of different deep models with 

selected metrics.

Deep Learning Tool Opens the Deep Learning Tool, with which you can train deep models for image segmentation and 

regression tasks.

Description

Auto Process Stack Opens the Auto Process Stack panel on the right sidebar, which enables real-time automatic processing 

of serial section 2D stack experiments.

Macro Builder Opens the Macro Builder, which provides an intuitive, visual way to build and edit complex macros or to 

combine multiple macros for batching.

Macro Player Opens the Macro Player, in which you can record and play macros.

Screen Recorder Opens the Screen Recorder dialog, which lets you start recording your full screen while working with 

Dragonfly.

Camera Position 

Bookmarker
Opens the Camera Position Bookmarker, in which you can bookmark and apply camera positions.

Opacity Console Opens the Opacity Setting dialog, in which you adjust the opacity of multiple objects.

Action Log Viewer Opens the Action Log Viewer console, in which you view all the actions that were performed during the 

current session.

Python Console Opens the Python console, which provides a quick way to execute commands and explore possibilities 

that can be pasted into larger scripts.

Report Generator* Opens the Report Generator panel on the left sidebar, in which you can generate a report from saved 

XML data.

Execute DOS Command Opens the Command dialog, in which you can enter common DOS commands.

Start Command Prompt Opens the Command Prompt window, which lets you access the Python environment from Dragonfly.

Start Command Prompt (as 

Administrator)
Opens the Command Prompt window in Administrator mode.

Open All Users Folder in File 

Browser

Automatically opens the Dragonfly directory with the Python All Users Extensions folder in your installed 

file manager.

Open Current Users Folder 

in File Browser

Automatically opens the Dragonfly directory with the Python Users Extensions folder in your installed file 

manager.

Infinite Toolbox Opens Dragonfly's Infinite Toolbox, in which you can submit, browse, and download extensions that 

implement new features and workflows.

Open Plugins Lets you directly access plug-ins from a drop-down menu.
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* New for version 2020.1.

Developer Menu
The new items listed below are available for the Developer menu. Other changes are 
also noted.

Developer menu changes

Help Menu
The new items listed below are available for the Help menu.

Help menu additions

Structured Grids 

Comparator*
Opens the Structured Grids Comparator dialog, in which you can evaluate the quality of processed 

image data, regions of interest, or multi-ROIs (see Structured Grids Comparator on page 40).

Graph Shortest Path* Opens the Graph Shortest Path dialog, in which you can compute the shortest distance between two 

selected nodes on a graph and then extract additional scalar values within that interval (see Computing 

Shortest Distances on Graphs on page 33).

Description

Description

Developer Documentation Opens the Dragonfly technical documentation package for developers.

NOTE Was moved from the Help menu.

Widget Observer Opens the Widget Observer panel, from which you can examine the properties of the parents and childs 

of a selected widget (see Widget Observer on page 45).

Deep Model Architecture 

Generator
Opens the Deep Model Architecture Generator dialog, in which you can create the architecture for a 

new deep model.

FIle Loader Generator Opens the File Loader Generator dialog, with which you can create a new file load option.

Description

Request Non-Commercial 

License
Opens the Request a Non‐Commercial License dialog, in which you can request a non-commercial 

license (see Academic Licensing Requests on page 61).
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Changes to Contextual Menus
The following changes and new items for the contextual menus are implemented for 
Dragonfly 2020.1.

Data Properties and Settings Panel
The following contextual menu items are now available for selected image data, 
annotations, regions of interest, multi-ROIs, meshes, shapes, vector fields, and graphs 
on the Data Properties and Settings panel.

Dataset Pop‐Up Menu
A number of new items, listed below, are available for the Dataset pop-up menu. Other 
changes, such as deprecated items, are also listed.

Dataset pop‐up menu changes

Annotation Pop‐Up Menu
A number of new items, listed below, are available for the Annotation pop-up menu. 
Other changes are also noted.

Annotation pop‐up menu changes

* Available only for rulers.

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Export as DICOM Provides the option to export images in the DICOM format (see Export Images as DICOM on page 43).

Segment with AI Replaces the item ‘Segment with Classifier’ (see Automated Segmentations on page 55).

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Create Mask Lets you quickly create an ROI mask with the same shape as the selected image data and that is fully 

labeled within the selected dimension and increment. (see Creating Image Masks on page 42).

Find Path ROI Between 

ROIs

Automatically computes the path linking two regions of interest (see Find Path Between ROIs on 

page 39).

Bone Analysis Wizard Opens the Bone Analysis Wizard, which is designed for the evaluation of high-resolution micro-CT 

image data of bone specimens (see Bone Analysis Wizard on page 18).

Plug Analysis Wizard Opens the Plug Analysis Wizard, which provides a dedicated workflow for analyzing core plugs 

acquired from rock samples and other porous media (see Plug Analysis Wizard on page 22).

Segmentation Wizard Opens the Segmentation Wizard, which provides an easy-to-use, guided workflow for implementing 

powerful deep learning and classical machine learning segmentation of multi-dimensional images (see 

Segmentation Wizard on page 15).

Open Processed Image 

Comparator
Opens the Processing Image Comparator dialog, in which you can compare processed images with a 

ground truth using selected metrics (see Structured Grids Comparator on page 40).

NOTE This option is available for multiple selections only.

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Align Current View Normal* Automatically aligns the normal of the current view with the selected ruler.
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ROI Pop‐Up Menu
A number of new items, listed below, are available for the Region of Interest pop-up 
menu. Other changes are also noted.

ROI pop‐up menu changes

Multi‐ROI Pop‐Up Menu
A number of new items, listed below, are available for the Multi‐ROI pop-up menu. 
Other changes are also noted.

Multi‐ROI pop‐up menu changes

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Create Dense Multi-ROI 

from ROIs

Creates a new multi-ROI, in which the labeled voxels of each selected ROI is assigned to a class and all 

unlabeled, or 'complementary' voxels, are labeled as an additional class (see Creating Dense Multi-ROIs 

from ROIs on page 29).

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Get Euler Characteristic 

Number

Automatically computes the Euler Characteristic number of the selected ROI (see Euler Characteristic 

Number on page 39).

Open Segmentation 

Comparator
Opens the Segmentation Comparator dialog, in which you can compare regions of interest with a 

ground truth using selected metrics (see Structured Grids Comparator on page 40).

NOTE This option is available for multiple selections only.

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Create Dense Multi-ROI Creates a new multi-ROI, in which all unlabeled, or 'complementary' voxels, are labeled and assigned to a 

new class (see Creating Dense Multi-ROIs from Multi-ROIs on page 30).

Compute Watershed 2D Lets you perform a Watershed segmentation on a single slice of a multi-ROI (see 2D Watershed on 

page 30).

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Create Images from Scalars Automatically creates an image for each scalar value checked in the Select Desired Scalars dialog 

(see Creating Images from Selected Scalars on page 30).

Fill Multi-ROI with New Class Adds a new class to the multi-ROI in which all unlabeled voxels are labeled.

Create Cubic Mesh Item deprecated. Options to create meshes from multi-ROIs are available on the Segment tab on the left 

sidebar.

Open Segmentation 

Comparator
Opens the Segmentation Comparator dialog, in which you can compare multi-ROIs with a ground truth 

using selected metrics (see Structured Grids Comparator on page 40).

NOTE This option is available for multiple selections only.
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Mesh Pop‐Up Menu
A number of new contextual items, listed below, are available for meshes. Other 
changes are also noted.

Mesh pop‐up menu changes

Shape Pop‐Up Menu
A number of new items, listed below, are available for the Shape pop-up menu. Other 
changes are also noted.

Pop‐up menu changes for shapes

Description

Export Mesh to File with 

Colors

Lets you export scalar meshes in the VRML (*.wrl extension) file format with vertex colors preserved.

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Align Axis of Inertia Lets you automatically align the axis of inertia of the current mesh with the axis of inertia of another mesh.

Add Vertex Normal Angle 

from Z Axis Scalar Value

Automatically computes and adds normal angles from the Z-axis (see Scalar Values for Meshes on 

page 36).

Apply Translation to Scalar 

Values

Lets you apply a linear transformation, with or without an offset, to the values of the selected scalar type.

Compute Gaussian 

Curvature

Automatically computes and adds scalar values of curvature calculated with the Gaussian method (see 

Scalar Values for Meshes on page 36).

Compute Mean Curvature Automatically computes and adds scalar values of curvature calculated with the Mean method (see 

Scalar Values for Meshes on page 36).

Create Vertex Scalar 

Distance from Mean Points

Automatically computes and adds scalar values of distances calculated from the mean position of a series 

of points.

NOTE You must first create a points series with the Point tool to enable this item.

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Manage User Data Opens the User Data dialog, in which you can add metadata to the selected item (see Managing User 

Data on page 60).

Remove from Structured 

Grid

This item does one of the following:

• Removes all labeled voxels in the selected region of interest or multi-ROI that intersect with the voxels 

contained in the subvolume defined by the current shape(s).

• Overwrites all voxels in the selected image data that intersect with the voxels contained in the 

subvolume defined by the current shape(s). New values will be ‘0’.

NOTE This item was previously available only for regions of interest.
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Vector Field Pop‐Up Menu
A number of new items, listed below, are available for the Vector Field pop-up menu. 
Other changes are also noted.

Pop‐up menu changes for vector fields

Graph Pop‐Up Menu
A number of new items, listed below, are available for the Graph pop-up menu. Other 
changes are also noted.

Pop‐up menu changes for graphs

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Manage User Data Opens the User Data dialog, in which you can add multiple attributes to the selected data (see Managing 

User Data on page 60).

Delete Selected Scalar 

Values

Lets you delete selected measurements. You can select multiple scalar value slots when deleting scalar 

information.

Import Scalar Values from 

CSV File

Lets you import scalar values contained in a comma-separated values (*.csv extension) file. Scalar values 

can imported from either an ORS-formatted CSV file, in which case all slots will be imported, or you can 

import scalar slots one-by-one from a generic CSV file that contains the required IDs and corresponding 

values.

Map Scalar Values From Lets you map vertex scalar values contained within another object to the selected vector field.

Add a Constant Vertex 

Measurement

Lets you add a constant vertex measurement to the selected vector field.

Apply Translation to Scalar 

Values

Lets you apply a linear transformation, with or without an offset, to the values of the selected scalar type.

Export Data to CSV File Lets you export vector fields in the selected comma-separated values (*.csv extension) file format.

Description

Edit Object Description Item deprecated. Replaced with ‘Manage User Data’.

Manage User Data Opens the User Data dialog, in which you can add multiple attributes to the selected data (see Managing 

User Data on page 60).

Plot Graph Tortuosity Lets you plot the tortuosity within a graph of porous media (see Plotting Tortuosity on page 32).

Plot Graph Throat Weighted 

Tortuosity

Lets you plot the throat-weighted tortuosity within a graph of porous media (see Plotting Throat-Weighted 

Tortuosity on page 33).

Copy in an ROI as Sphere 

and Cylinder

Lets you copy a graph into a region of interest as labeled spheres and cylinders, with either a fixed radius 

or radii computed from a selected scalar slot.

Apply Translation to Scalar 

Values

Lets you apply a linear transformation, with or without an offset, to the values of the selected scalar type.

Create Vertex Scalar 

Distance from Mean Points

Automatically computes and adds scalar values of distances calculated from the mean position of a series 

of points.

NOTE You must first create a points series with the Point tool to enable this item.

Get Euler Characteristic 

Number

Automatically computes the Euler Characteristic number of the selected graph (see Euler Characteristic 

Number on page 39).

Create Euclidean Length 

Scalar Values

Automatically adds measurements of Euclidean length to the edge scalar values.



70 Changes to Contextual Menus
Views Pop‐Up Menus

Dragonfly Release Notes Version 2020.1

T
M

0
2

1
-A

-0
7

Context Group Pop‐Up Menu
This new contextual menu is available for the context groups created when working 
with the Segmentation, Bone Analysis, and Plug Analysis wizards.

Pop‐up menu for context groups

Views Pop‐Up Menus
A number of new options are available for the 2D and 3D views pop-up menus.

Views pop‐up menu changes

* Available for 2D views only.

Description

Export Lets you export the selected context group in the ORS Object file format (*.ORSObject extension).

Extract Objects from Context 

Group

Lets you extract selected objects from the context group. The objects included in the context group can be 

selected in the Select Objects dialog, shown below.

Execute Macro Provides a shortcut for selecting macros that can be executed for the context.

Manage User Data Opens the User Data dialog, in which you can add multiple attributes to the selected context (see 

Managing User Data on page 60).

Reopen... Lets you reopen the selected context and continue your workflow.

Description

Orthogonalize Other 2D 

Views*

Automatically resets all other 2D views in the current scene to be orthogonal to the current scene view. 

For example, after you have created an oblique or double-oblique view.

Export Screenshot of View Lets you export a screenshot of the current view — including its scale bar, legend, annotations, overlays, 

and other objects that are visible onscreen — to a number of standard image file formats.

NOTE A no background option is available for exporting screenshots of 3D views (see Export 

Screenshots with Transparent Backgrounds on page 44).
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Preferences Changes
A number of new items, listed below, and other changes have been implemented for the 
setting the application preferences. You should note that a new set of preferences for 
the Organizer have also been added to the Preferences dialog.

Click Preferences on the Status bar or choose File > Preferences on the Menu bar to 
open the Preferences dialog.

Views Preferences
Changes for the Views preferences are indicated in the following table.

Views preferences changes

Configurable Actions
New items for the Configurable Actions preferences are indicated in the following table.

Configurable Actions changes

Description

Colors

Virtual floor Lets you choose a color for the virtual floor option for 3D views (see Scene's Views Properties on 

page 11).

Fonts

User interface font size Lets you choose a font size, in points, for interface elements such as panels, dialogs, and other controls.

3D Settings

Use new rendering engine Lets you enable Dragonfly’s new rendering engine (see Enabling the New Engine and Setting Defaults on 

page 10).

Default preset Lets you set a default preset for 3D views whenever the new rendering engine is enabled.

Gamma correction Lets you set a default Gamma correction for 3D views whenever the new rendering engine is enabled.

Interactivity Lets you set a default Interactivity setting for 3D views whenever the new rendering engine is enabled.

Break during motion Lets you set a short delay or interval before the requested quality is applied. This can avoid unnecessary 

delays when making multiple changes to 3D views, such as rotation, pans, window leveling, and so on.

Description

Center MPR 2D views from 

3D pick

Lets you automatically update the slice position of all MPR views in the scene to where you clicked in the 

3D view.

Constrain ellipse to be round Constrain the Ellipse tool to a circle.

Open the Widget Observer Opens the Widget Observer panel on the right sidebar (see Widget Observer on page 45).

Start Widget Observer 

(graph) on widget at cursor

Opens the Graph Observer and displays the properties of the selected instance of class. For example, 

‘OrsPythonPlugins.OrsBasicManipulate.mainform.mainform’.

Start Widget Observer 

(single widget) on widget at 

cursor

Opens the Widget Observer and displays the properties of the selected instance of class. For example, 

‘OrsPythonPlugins.OrsBasicManipulate.mainform.mainform’.
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Miscellaneous
Changes for the Miscellaneous preferences are indicated in the following table.

Miscellaneous preferences changes

Organizer
The new set of preferences for the Organizer is available in the 2020.1 software 
release.

Organizer preferences

Description

GPU card for Deep Learning Lets you designate a specific GPU for deep learning (see Selectable GPU for Deep Learning on page 51).

Description

Start the Organizer 

automatically

If selected, the Organizer will appear automatically onscreen whenever you start Dragonfly.

Synchronize object names 

with Properties list

If selected, object names edited in the Data Properties and Settings panel with be updated automatically 

in the Organizer and vice-versa.
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System Requirements
This release supports the base system requirements.

Changes to the System Requirements
Changes to the base system requirements are noted below.

System requirements changes

Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Utilities > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.

Version Changes to system requirements

3.0.0 None.

3.1.0 None.

NOTE Dragonfly 3.1 includes a new Anaconda distribution for Python. You should note that the current 

version of Python accessed by Dragonfly will be updated automatically to version 3.6 when you install this 

new release.

3.5.0 None.

3.6.0 None.

4.0.0 None.

NOTE The Anaconda distribution was changed to version 5.2.0 for this software release. You should also 

note that the current version of Python accessed by Dragonfly will be updated automatically to version 

3.6.5 when you install this new release. In addition, the Anaconda distribution will be installed in the 

ProgramData folder, as shown below, instead of the Program Files directory.

This change was implemented to allow users to update Dragonfly without running in Administrator mode. 

If you are updating a previous installation, the current Anaconda distribution will be deleted from the 

Program Files folder.

4.1.0 None.

2020.1 None.

NOTE The current version of Python accessed by Dragonfly will be updated automatically to version 3.7.3 

when you install this new release.
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Getting Help
Learning Dragonfly
Just by taking a quick look around www.theobjects.com/dragonfly, you’ll find some 
great free resources, such as our latest instructional videos, recorded webinars, and 
user forums.

Dragonfly Workshops
Our hands-on training workshops are a great way to get up and running quickly. 
Combining in-depth instruction with class exercises, our product specialists will quickly 
teach you how to use key Dragonfly features and functions to optimize your image 
visualization and analysis tasks.

Check for upcoming workshops on our website at:
http://www.theobjects.com/dragonfly/workshops.html.

Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > 
Report an Issue on the menu bar.
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